
Ansoft HFSS 边界条件 讲解 

这一章主要介绍使用边界条件的基本知识。边界条件能够使你能够控制物体之间平面、表面或交界面处的特性。边界条件对理

解麦克斯韦方程是非常重要的同时也是求解麦克斯韦方程的基础。 

§2.1  为什么边界条件很重要 

用 Ansoft HFSS求解的波动方程是由微分形式的麦克斯韦方程推导出来的。在这些场矢量和它们的导数是都单值、有界而且沿

空间连续分布的假设下，这些表达式才可以使用。在边界和场源处，场是不连续的，场的导数变得没有意义。因此，边界条件

确定了跨越不连续边界处场的性质。 

作为一个 Ansoft HSS 用户你必须时刻都意识到由边界条件确定场的假设。由于边界条件对场有制约作用的假设，我们可以确

定对仿真哪些边界条件是合适的。对边界条件的不恰当使用将导致矛盾的结果。 

当边界条件被正确使用时，边界条件能够成功地用于简化模型的复杂性。事实上，Ansoft HSS 能够自动地使用边界条件来简化

模型的复杂性。对于无源 RF 器件来说，Ansoft HSS 可以被认为是一个虚拟的原型世界。与边界为无限空间的真实世界不同，

虚拟原型世界被做成有限的。为了获得这个有限空间， Ansoft HSS使用了背景或包围几何模型的外部边界条件。 

 

模型的复杂性通常直接与求解问题所需的时间和计算机硬件资源直接联系。在任何可以提高计算机的硬件资源性能的时候，提

高计算机资源的性能对计算都是有利的。 

 

§2.2  一般边界条件 

有三种类型的边界条件。第一种边界条件的头两个是多数使用者有责任确定的边界或确保它们被正确的定义。材料边界条件对

用户是非常明确的。 

1、  激励源 

波端口（外部） 

集中端口（内部） 

2、  表面近似 

对称面 

理想电或磁表面 

辐射表面 

背景或外部表面 

3、  材料特性 

两种介质之间的边界 

具有有限电导的导体 

§2.3  背景如何影响结构 

       所谓背景是指几何模型周围没有被任何物体占据的空间。任何和背景有关联的物体表面将被自动地定义为理想的电边界

（Perfect E）并且命名为外部（outer）边界条件。你可以把你的几何结构想象为外面有一层很薄而且是理想导体的材料。 

如果有必要，你可以改变暴露于背景材料的表面性质，使其性质与理想的电边界不同。为了模拟有耗表面，你可以重新定义这

个边界为有限电导（Finite Conductivity ）或阻抗边界（Impedance boundary）。有限电导边界可以是一种电导率和导磁率

均为频率函数的有耗材料。阻抗边界默认在所有频率都具有相同的实数或复数值。为了模拟一个允许波进入空间辐射无限远的

表面，重新定义暴露于背景材料的表面为辐射边界（Radiation Boundary）。 

 

       背景能够影响你怎样给材料赋值。例如，你要仿真一个充满空气的矩形波导，你可以创建一个具有波导形状特性为空气的

简单物体。波导表面自动被假定为良导体而且给出外部（outer）边界条件，或者你也可以把它变成有损导体。 
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§2.4  边界条件的技术定义 

激励（Excitation）——激励端口是一种允许能量进入或导出几何结构的边界条件。 

理想电边界（Perfect E）——Perfect E是一种理想电导体或简称为理想导体。这种边界条件的电场（E-Field）垂直于表面。

有两种边界被自动地赋值为理想电边界。 

1、   任何与背景相关联的物体表面将被自动地定义为理想电边界并且命名为 outer的外部边界条件。 

2、   任何材料被赋值为 PEC（理想电导体）的物体的表面被自动的赋值为理想电边界并命为 smetal边界。  

理想磁边界（Perfect H）——Perfect H是一种理想的磁边界。边界面上的电场方向与表面相切。 

自然边界（Natural）——当理想电边界与理想磁边界出现交叠时，理想磁边界也被称为 Natural边界。理想磁边界与理想电边

界交叠的部分将去掉理想电边界特性，恢复所选择区域为它以前的原始材料特性。它不会影响任何材料的赋值。例如，可以用

它来模拟地平面上的同轴线馈源图案。 

       有限电导率（Finite Conductivity）边界——有限电导率边界将使你把物体表面定义有耗（非理想）的导体。它是非理想

的电导体边界条件。并且可类比为有耗金属材料的定义。为了模拟有耗表面，你应提供以西门子/米（Siemens/meter）为单位

的损耗参数以及导磁率参数。计算的损耗是频率的函数。它仅能用于良导体损耗的计算。其中电场切线分量等于 Zs(n xHtan)。

表面电阻（Zs）就等于 (1+j)/(δσ)。其中， 

 

δ是趋肤深度；导体的趋肤深度为  

 

ω是激励电磁波的频率. 

 

σ是导体的电导率  

 

µ 是导体的导磁率 

 

阻抗边界（Impedance）——一个用解析公式计算场行为和损耗的电阻性表面。表面的切向电场等于 Zs(n xHtan)。表面的阻

抗等于 Rs + jXs。其中， 

 

Rs是以 ohms/square为单位的电阻 

 

Xs 是以 ohms/square为单位的电抗 

 

分层阻抗（Layered Impedance）边界——在结构中多层薄层可以模拟为阻抗表面。使用分层阻抗边界条件进一步的信息可以

在在线帮助中寻找。 

 

集总 RLC（Lumped RLC）边界 ——一组并联的电阻、电感和电容组成的表面。这种仿真类似于阻抗边界，只是软件利用用

户提供的 R、L和 C值计算出以 ohms/square为单位的阻抗值。 

 

无限地平面（Infinite Ground Plane）——通常，地面可以看成是无限的、理想电壁、有限电导率或者是阻抗的边界条件。如

果结构中使用了辐射边界，地面的作用是对远区场能量的屏蔽物，防止波穿过地平面传播。为了模拟无限大地平面的效果，在

我们定义理想电边界、有限电导或阻抗边界条件时，在无限大地平面的框子内打勾。 
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辐射边界（Radiation）——辐射边界也被称为吸收边界。辐射边界使你能够模拟开放的表面。即，波能够朝着辐射边界的方向

辐射出去。系统在辐射边界处吸收电磁波，本质上就可把边界看成是延伸到空间无限远处。辐射边界可以是任意形状并且靠近

结构。这就排除了对球形边界的需要。对包含辐射边界的结构，计算的 S参数包含辐射损耗。当结构中包含辐射边界时，远区

场计算作为仿真的一部分被完成。 

 

§2.5  激励技术综述 

 

       端口是唯一一种允许能量进入和流出几何结构的边界类型。你可以把端口赋值给一个两维物体或三维物体的表面。在几何

结构中三维全波电磁场被计算之前，必须确定在每一个端口激励场的模式。Ansoft HFSS使用任意的端口解算器计算自然的场

模式或与端口截面相同的传输线存在的模式。导致两维场模式作为全三维问题的边界条件。 

 

        Ansoft HFSS默认所有的几何结构都被完全装入一个导电的屏蔽层，没有能量穿过这个屏蔽层。当你应用波端口（Wave 

Ports）于你的几何结构时，能量通过这个端口进入和离开这个屏蔽层。 

 

       作为波端口的替代品，你可以在几何结构内应用集中参数端口（Lumped Ports）。集中参数端口在模拟结构内部的端口

时非常有用。 

 

§2.5.1 波端口（Wave Ports） 

 

       端口解算器假定你定义的波端口连接到一个半无限长的波导，该波导具有与端口相同的截面和材料。每一个端口都是独立

地激励并且在端口中每一个入射模式的平均功率为 1瓦。波端口计算特性阻抗、复传播常数和 S参数。 

 

       波动方程 

 

       在波导中行波的场模式可以通过求解Maxwell方程获得。下面的由Maxwell方程推出的方程使用两维解算器求解。 

 

 

 
       其中： 

                是谐振电场的矢量表达式； 

                是自由空间的波数； 

                是复数相对导磁率； 

                是复数相对介电常数。 

       求解这个方程，两维解算器得到一个矢量解 形式的激励场模式。这些矢量解与 和 无关，只要在矢量解后面

乘上 它们就变成了行波。 

       另外，我们注意到激励场模式的计算只能在一个频率。在每一个感兴趣的频率，计算出的激励场模式可能会不一样。 
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§2.5.2 模式（Modes） 

 

 

对于给定横截面的波导或传输线，特定频率下有一系列的场模式满足麦克斯维方程组。这些模式的线性叠加都可以在波导中存

在。 

    模式转换 

        某些情况下，由于几何结构的作用像一个模式变换器，计算中包括高阶模式的影响是必须的。例如，当模式 1（主模）从

某一结构的一个端口（经过该结构）转换到另外一个端口的模式 2时，我们有必要得到模式 2下的 S参数。 

    模式，反射和传播 

        在单一模式的信号激励下，三维场的解算结果中仍然可能包含由于高频结构不均匀引起的高次模反射。如果这些高次模反

射回激励源端口，或者传输到下一个端口，那么和这些高次模相关的 S参数就必须被考虑。如果高次模在到达任何端口前，得

到衰减（这些衰减由金属损耗或者传播常数中的衰减部分所造成），那么我们就可以不考虑这些高次模的 S参数。 

    模式和频率 

         一般来说，和每种模式相关的场模式也许会随频率的改变而变化。然而，传播常数和特性阻抗总是随频率变化的。因此，

需要频扫时，在每一个频率点，都应有相应的解算。通常，随着频率的增加，高次模出现的可能性也相应的增加。 

模式和 S参数 

    当每个端口的定义都正确时，仿真中包括的每个模式，在端口处都是完全匹配的。因此，每个模式的 S参数和波端口，将会

根据不同频率下的特性阻抗进行归一化。这种类型的 S参数叫做广义的 S参数。 

    实验测量，例如矢量网络分析仪，以及电路仿真器中使用的特性阻抗是常数（这使得端口在各个频率下不是完全匹配）。 

    为了使计算结果，和实验及电路仿真得到的测量结果保持一致，由 HFSS得到的广义 S参数必须用常数特性阻抗进行归一

化。如何归一化，参看波端口校准。 

注解：对广义 S参数归一化的失败，会导致结果的不一致。例如，既然波端口在每一个频点都完全匹配，那么 S参数将不会表

现出各个端口间的相互作用，而实际上，在为常数的特性阻抗端口中，这种互作用是存在的。 

§2.5.3 波端口的边界条件： 

波端口边缘有以下所述的边界条件： 

    理想导体或有限电导率边界—在默认条件下，波端口边缘的外部定义为理想导体。在这种假设条件下，端口定义在波导之内。

对于被金属包裹传输线结构，这是没问题的。而对于非平衡或者没被金属包围的传输线，在周围介质中的场必须被计算，不正

确的端口尺寸将会产生错误的结果。 

    对称面——端口解算器可以理解理想电对称面（Perfect E symmetry）和理想磁对称面（Perfect H symmetry）面。使用

对称面时，需要填入正确的阻抗倍增数。 

    阻抗边界——端口解算将识别出端口边缘处的阻抗边界。 

辐射边界——在波端口和辐射边界之间默认的设置是理想导体边界。 

§2.5.4 波端口校准： 

     一个添加到几何结构的波端口必须被校准以确保一致的结果。为了确定场的方向和极性以及计算电压，校准是必要的。 

§2.5.5求解类型:模式驱动 

     对于模式驱动的仿真，波端口使用积分线校准。每一条用于校准的积分线线都具有以下的特性： 

     阻抗：作为一个阻抗线，这条线作为 Ansoft HFSS在端口对电场进行积分计算电压的积分路径。Ansoft HFSS利用这个电

压计算波端口的特性阻抗。这个阻抗对广义 S参数的归一化是有用的。通常，这个阻抗指定为特定的值，例如，50欧姆。 

     注意：如果你想有能力归一化特性阻抗或者想观察 Zpv或 Zvi的值就必须在端口设定积分线。 

校准：作为一条校准线，这条线明确地确定每一个波端口向上或正方向。在任何一个波端口， 时的场的方向至少是两个方向中

的一个。在同一端口，例如圆端口，有两个以上的可能的方向，这样你将希望使用极化（Polarize）电场的选项。如果你不定义

积分线，S参数的计算结果也许与你的期望值不一致。 

 

提示：也许你需要首先运行端口解（ports-only solution ），帮助你确定如何设置积分线和它的方向。 
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为了用积分线校准一个已经定义的波端口，要做一下操作： 

 

1.      在项目树（Project Tree）中打开激励（Excitations），并双击被校准的波端口。 

2.      选择模型（Modes）列表。 

3.      从列表中为第一个模型选择积分线（Integration Line）一列。然后，选择新线（New Line）。 

4.      使用下列方法中的一种进行位置和长度的设置： 

直接输入线段起点和终点相对工作坐标系的 x,y和 z坐标。关于坐标系更多的信息，请参阅 XX章。 

在绘图窗口的点击。这条线显示为矢量，指明了方向。如需要改变线段的方向，在积分线（Integration Line）一列，选择切换

终点（Swap Endpoints）。 

5.      重复 3、4步，设置该端口其它模式的积分线。 

6.      完成积分线定义后点击 OK。 

7.      重复 1－6步，设置其它波端口的积分线。 

 

 
 

 

关于阻抗线 

Ansoft HFSS开始计算的 S矩阵值是对每个端口的阻抗进行归一化的结果。然而，我们经常希望计算对某一个特定阻抗如 50

欧姆归一化的 S矩阵。为了将广义 S矩阵转化成归一化 S矩阵，Ansoft HFSS需要计算各端口的特征阻抗。计算特征阻抗的方

法有很多种（Zpi, Zpv, Zvi）。 

Ansoft HFSS始终会计算 Zpi。这个阻抗的计算使用波端口处的功率和电流。另外两种方法 Zpv和 Zvi需要计算电压的积分线。

利用每一个模式的积分线，可以计算出电压值。 
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一般来说，阻抗线应该定义在电压差值最大方向上的两点之间。如果你要分析多个模式，由于电场方向的变化，需对每个模式

分别定义不同的阻抗线。 

关于校准线： 

在计算波端口激励的场模式时,场在 ωt＝0时的方向是任意的且指向至少两个方向中的一个。利用参考方向或参考起点，积分线

能够校准端口。需确认每一个端口定义的积分线参考方向都与类似或相同截面端口的参考方向相同。用这种方法，试验室的测

量（通过移去几何结构，两个端口连接在一起的方法校正设置）得以重现。 

由于校准线仅仅确定激励信号的相位和行波，系统在只对端口解算（ports-only solution ）时可以将其忽略不计。 

§2.5.6求解类型:终端驱动 

Ansoft HFSS计算的以模式为基础的 S矩阵表示了波导模式入射和反射功率的比值。上面的方法，不能准确地描述那些有多个

准横电磁波（TEM）模式同时传播的问题。这种支持多个准横电磁波（TEM）模式的结构有耦合传输线或接头等。它们通常使

用端口 S参数。 

需要用终端线校准已定义的波端口： 

1.      在项目树（Project Tree）中打开激励（Excitations），并双击被校准的波端口。 

2.      选择终端（Terminals）列表。 

3.      从列表中为第一个模型选择终端线（Terminal Line）一列。然后，选择新线（New Line）。 

4.      使用下列方法中的一种进行位置和长度的设置： 

直接输入线段起点和终点相对工作坐标系的 x,y和 z坐标。关于坐标系更多的信息，请参阅 XX章。 

在绘图窗口的点击。这条线显示为矢量，指明了方向。如需要改变线段的方向，在终端线（Terminal Line）一列，选择切换终

点（Swap Endpoints）。 

5.      重复 3、4步，设置该端口其它终端线。 

6.      完成终端线定义后点击 OK。 

7.      重复 1－6步，设置其它波端口的终端线。 

 

关于终端线： 

终端的 S参数反映的是波端口节点电压和电流的线性叠加。通过节点电压和电流端口的导纳、阻抗和赝 S参数矩阵就能被确定。 

    对每个与导体相交的端口，Ansoft HFSS自动将模式解转变成终端解。 

一般来说，一个单终端线都是建立在参考面或“地”导体与每一个端口的导体之间。  

电压的参考极性用终端线的箭头确定，头部（＋）为证，尾部（—）为负。来的。如果你决定建立了终端线，你就必须在每一

个端口和每端口都建立终端线。 

§2.5.7 定义波断口的几点考虑 

 

波端口的定位： 

露于背景的面设定为波端口。背景已经被命名为 Outer. 因此，一个面如果表露于背景则它与 outer相连。用户可以通过主菜单

HFSS Boundary Display（Solver View）选择所有的区域定位。从 Solver View of Boundaries，点击 Visibility查看 outer。 
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内部波端口： 

结构内部定义波端口，你必须在内部建立一个不存在的空间或者在已存在物体内侧选择一个面并将它的材料定义成为理想导体。

内部不存在的空间自动将边界赋值为 outer。你可以创建一个整个由其它物体包围的内部空间，然后，从这个物体中剪掉这个空

间。 

 

端口平面： 

端口设在单一平面。不允许端口平面弯曲。例如：一个几何体有一个弯曲的表面，该表面暴露于背景，则这个弯曲的表面不能

被定义成波端口。 

§2.5.8 端口要求一定长度的均匀横截面 

Ansoft HFSS假定你所定义的每个端口都与连接到一个于端口具有相同横截面的半无限长波导。但求解 S参数时，仿真器假定

其几何结构被具有这些截面的自然模式激励。下面的图将说明这些横截面。第一个图显示直接在结构外面的导体表面定义了波

端口。 

 

 

第二张图显示，模型结构必须添加均匀横截面部分。左边模型结构有误，原因是在模型两个端口都没有均匀横截面的部分。为
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了正确建模，需在每个波端口处添加一段均匀横截面的传输线，如右图所示。 

均匀横截面部分的长度必须足够的长，这样才能保证截止模式逐渐消失。以保证仿真结果的精确。例如：如果一个截止模式由

于损耗和模式截止大约经过 1/8波长逐渐消逝了，这就需要构造一个长度为 1/8波长的均匀波导段。否则，仿真结果中一定会包

含高次谐波的影响。 

 

在端口处附近的不连续性同样可以使截止模式传播到端口。如果端口放置在很靠近不连续性处，由于端口处的边界条件导致仿

真结果与对应的真实值不同（即：系统迫使每一个端口都是你要求求解模式的线性叠加）。截止模式中的能量传播到端口将会

影响主模的能量并产生错误的结果。 

如果波在 Z方向上传播，模式的削减可以用函数 。因此，所需的距离（均匀端口长度）由模式的传播常数值决定。 

当端口长度设置正确时，在端口处仿真的模为理想匹配，如同波导延伸至无穷远处一般。对仿真中没有包含的模，波端口可被

看成理想导体。 

§2.5.9 端口和多重传播模式 

每个高次模都表现为沿着波导传播的不同的场模式。通常，仿真中应包括所有的传播模式。在大多数情况下，你可以接受默认

的单模模式，但是对那些传播高次模的问题，我们需要改变默认设置，将其改变成多模模式。如果实际传播模式数比你指定指

定的模式数多，就会产生错误的结果。模式的数量随端口不同而不同。 

传播模式 

传播模式是指那些具有传播常数 β（rad/m）并且 β远大于衰减常数 α（Np/meter）的模式。用下面的方法可确定那些仿真问题

中应包括的模式，首先设置成不包括自适应解的多模模式问题，然后求解。在完成分析之后检验每个模的复传播常数（Gamma）

γ=α+β：为了能够在完成分析之后检验每个模的复传播常数： 

1. 在 HFSS的 Analysis Setup菜单中，选择Matrix Data。 

2. 此时会弹出一个对话框如下图所示。选择 Gamma并改变显示类型为 Real/Imaginary。 
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在端口每一个附加的模式将产生一组附加的 S参数。假如，在一个 3端口器件中每个端口设置 2个模进行分析，其最终结果是

一个 6×6的 S参量矩阵。一般来说，n端口的解是由所有端口的激励数、模式数加上源的数量。 

如果在仿真中不包含高次模，则需确认波端口有足够的长的均匀段，使截止模凋落且不会产生反射。 

§2.5.10 波端口和对称面──阻抗倍乘 

当由于使用对称面使端口的尺寸减少时，为计算电压损耗和功率流需要调整端口阻抗。 

理想电对称面（Perfect E Symmetry plane）,阻抗倍乘因子为 2。该模型的电压差和功率流只有整个结构的 1/2，导致计算出

的阻抗也只有整个结构的 1/2。只有模型算出的阻抗乘 2以后，其阻抗值才与实际结构相同。 

 

理想磁对称面（Perfect H Symmetry plane），阻抗倍乘因子为 0.5。该模型计算的电压差与整个结构相同，但功率流只有整

个结构的 1/2，所以，算出的阻抗为整体结构的 2倍。所以，阻抗倍乘因子为 0.5。 

 

如果整体结构同时包含理想电对称面和理想磁对称面，则无需调整。也就是说，无需调整同时含有理想电边界和理想磁边界的

结构输入阻抗倍乘数，因为理想磁对称面的阻抗倍乘因子为 0.5，理想电对称面的阻抗倍乘因子为 2。两个阻抗倍乘因子相乘等

于 1 

 

 

 

 

 

 

HFSS边界条件（boundary） 
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Ansoft HFSS求解就是对微分形式的麦克斯韦方程采取有限元方法进行数值求
解，在场矢量和导数是都单值、有界而且沿空间连续分布的假设下，这些方程才

可以使用。在边界和场源处，场是不连续的，场的导数变得没有意义。因此，需

要边界条件确定跨越不连续边界处场的性质。边界条件对理解麦克斯韦方程是非

常重要的，同时也是求解麦克斯韦方程的基础。 

默认边界条件——Ansoft HFSS建立的是一个虚拟的原型世界。与边界

为无限空间的真实世界不同，虚拟原型世界被做成有限的。为了获得这个有限空

间，Ansoft HSS使用了背景或包围几何模型的外部边界条件。 
所谓背景是指没有被任何模型物体占据的空间。任何和背景有关联的物体表面将

被自动地定义为理想的电边界（Perfect E）并且命名为外部（outer）边界条件。
可以把几何结构想象为外面有一层很薄而且是理想导体的材料。因此当实际边界

不是理想的电边界就必须根据实际情况设置； 

激励（excitation）——激励边界条件是一种特殊的边界条件，最常用

的是 wave port，是一种允许能量进入或导出几何结构的边界条件，使用 wave 
port激励条件可以计算端口的 S参数； 

理想电边界（Perfect E）——Perfect E是一种理想电导体或简称为理

想导体。这种边界条件的电场（E-Field）垂直于表面。有两种边界被自动地赋
值为理想电边界。 
1、  任何与背景相关联的物体表面将被自动地定义为理想电边界并且命名为
outer的外部边界条件。 
2、  任何材料被赋值为 PEC（理想电导体）的物体的表面被自动的赋值为理想
电边界并命为 smetal边界。  
理想磁边界（Perfect H）——Perfect H是一种理想的磁边界。边界面上的电场
方向与表面相切。 
有限电导率（Finite Conductivity）——有限电导率边界将把物体表面定义有耗
（非理想）的导体。并且可类比为有耗金属材料的定义。为了模拟有耗表面，应

提供以西门子/米（Siemens/meter）为单位的损耗参数以及导磁率参数。并且可
以是频率的函数 
阻抗边界（Impedance）——一个用解析公式计算场行为和损耗的电阻性表面。
表面的切向电场等于 Zs(n xHtan)。表面的阻抗等于 Rs + jXs。其中，Rs是以
ohms/square为单位的电阻，Xs 是以 ohms/square为单位的电抗 
分层阻抗（Layered Impedance）边界——在结构中多层薄层可以模拟为阻抗
表面。 
集总 RLC（Lumped RLC）边界——一组并联的电阻、电感和电容组成的表面。
这种仿真类似于阻抗边界，只是软件利用用户提供的 R、L和 C值计算出以
ohms/square为单位的阻抗值。 
无限地平面（Infinite Ground Plane）——通常，地面可以看成是无限的、理
想电壁、有限电导率或者是阻抗的边界条件。如果结构中使用了辐射边界，地面
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的作用是对远区场能量的屏蔽物，防止波穿过地平面传播。 
辐射边界（Radiation）——辐射边界也被称为吸收边界。辐射边界使该边界能
够模拟开放的表面。即波能够朝着辐射边界的方向辐射出去。系统在辐射边界处

吸收电磁波，本质上就可把边界看成是延伸到空间无限远处。辐射边界可以是任

意形状并且靠近结构，但一般要距离模型四分之一波长，对包含辐射边界的结构，

计算的 S参数包含辐射损耗。当结构中包含辐射边界时，远区场计算作为仿真
的一部分被完成。 
PML（Perfectly matched layer）边界——这是个假想的材料能够完全吸收电
磁场，这些材料是各向异性的，有两种形式的 PML，一种是自由空间终止，它
意味着电磁场从这个表明辐射到自由空间的任意方向，这种情况下要比 radiation
边界更合适，因为 PML可以和模型距离很近，减少空间问题，另一中 PML是
反射自由终止，它类似一个波导，波沿该方向传播到无限； 
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HFSS设计一般步骤 

Ansoft HFSS提供了一个直观、易于使用、用于建立任意三维无源器件模型的界面。创建一个设计包括以

下几个步骤： 

1）File>New，然后点击 Project>Insert HFSS Design，新建一个 Project。当然可以通过 File>Open，打

开一个已经存在的 Project。 

2）HFSS>Solution Type，设置解算类型，确定如何激励和收敛。HFSS有三种解算类型，第一种是模式

驱动（Driven Modal），根据波导模式的入射和反射功率表示 S参数矩阵的解；第二种是终端驱动（Driven 

Terminal），根据传输线终端的电压和电流表示 S参数矩阵的解；第三种是本征模（Eignemode），求解

物理结构的谐振频率以及这些谐振频率下的场模式。 

3）创建互连结构模型。HFSS拥有强大的全参数三维模型创建功能，简单的实体建模中，直接使用 HFSS

中提供的基本图形（主菜单>Draw）即可，当创建复杂的物体时，可以用布尔运算操作（3D 

Modeler>Boolean）完成挖洞、切开或连接等功能。 

4）在创建每一个基本结构单元时，HFSS都会提示确定其属性，如介电常数等，默认的材料特性是真空

（Vacuum）。 

5）指定平面设置边界条件（HFSS>Boundaries>Assign）。HFSS有多种边界条件，在高速设计中最常用

的有，理想电边界（Perfect E）表示电场垂直于表面。任何与背景相关联的物体表面和任何被赋值为 PEC

（理想电导体）的物体表面将被自动地设置为 Perfect E边界；理想磁边界（Perfect H）是指电场方向与

表面相切；阻抗边界（Impedance）用解析公式计算场行为和损耗的电阻性表面；辐射边界（Radiation）

也被称为吸收边界，用来模拟开放的表面；完美匹配层边界（PML）用一种非实际的、阻抗与自由空间相

匹配吸收层来模拟开放空间。 

6）指定端口设置激励（HFSS>Excitations>Assign）。HFSS主要有波端口（Wave Ports）和集中端口

（Lumped Ports），而在高速设计中，使用波端口的情况比较多。HFSS假定你定义的波端口连接到一个

半无限长的波导，该波导具有与端口相同的截面和材料，每个端口都是独立地激励并且在端口中每一个入

射模式的平均功率为 1瓦，使用波端口可以计算特性阻抗、复传播常数和 S参数。 

值得注意的是，在设置波端口大小时也是很讲究的，以经常遇到微带线端口为例，如果设微带线宽为W，

高为 h，设置如图 1所示。 

 

 

图片附件: 1.gif (2007-1-18 10:44 AM, 2.07 K) 
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图 1 微带线波端口大小设置 

7）分析设置。通过 HFSS>Analysis Setup>Add Solution Setup可以进行自适应频率和收敛标准的设置，

通过 HFSS>Analysis Setup>Add Sweep可以得到互连结构的扫频响应，通常选择插值（Interpolating）扫

频。 

8）数据处理（HFSS>Results）。HFSS具有功能强大又很灵活的数据管理和绘图能力，可以输出适合于

Matlab编程，后缀为.m的 S/Y/Z矩阵参数文件。 
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HFSS V9.2的帮助文件部分翻译 

计算一个结构内的三维电磁场分布所用的仿真技术建立在有限元素法基础之上。虽然其执行过程大部分是

透明的，但大体了解该方法对于更加有效的使用 HFSS是很有帮助的。  

 

HFSS技术资料对有限元素法及其在 HFSS中的应用做了简单的介绍。它同时描述了如何通过仿真电场和

磁场来计算模式 S参数，以及这些参数如何被转化为基于电路理论中的虚拟 S参数的“节点”或“电压”。  

 

本部分包含以下信息：  

 

●有限元素法 ●激励  

 

●HFSS后处理 ●材料  

 

●S参数 ●参量分析  

 

●辐射场 ●优化分析  

 

●几何对象（实体） ●灵敏度分析  

 

●边界 ●调谐分析  

 

有限元素法  

 

为了求解电磁场的解，HFSS采用了有限元素法。一般来说，有限元素法将整个问题区域划分成几千个小

区域，然后用区域函数来描绘每个小区域（元素）内的场。  

 

在 HFSS中，几何模型被自动分成大量的四面体，每一个四面体都是一个四面锥。这些四面体的集合被称

为有限元网格。  

 

场量的表示方法  

 

矢量场（如电场 E，磁场 H）在四面体内各个点的值是通过四面体顶点值以内插值替换的方式来实现的。

在每个顶点，HFSS存储了与连到该顶点的三条楞相切的场分量。另外，HFSS还能存储所选楞中点的矢

量场分量，该矢量场与面相切，而与所在楞正交（如下图所示）。四面体内的场通过这些节点值内插替换

得到。  

 

通过这种方式描述场量，系统将麦克斯韦方程组转化为可用传统数字方法解决的矩阵方程组。  

 

基函数  

 

各种内插方案，或者说基本函数，可以用作从节点值内插替换场值。  

 

●一阶切向元素基函数通过顶点和边上的节点值来内插场值。一阶切向元素对于每个四面体来说有 20个未
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知量。  

 

●零阶基函数仅使用顶点的节点值——因此可假定场在每个四面体内部线性变化。零阶切向元素对于每个四

面体来说有 6个未知量。  

 

网格尺寸与精度  

 

在网格尺寸，预期精度，用到的计算资源量之间有一个交换关系。  

 

解决的精度依赖于所有单个元素的尺寸。一般来说，使用成千的元素计算得到的结果要比使用相对较少的

粗糙网格得到的结果更加精确。要精确的描述场量，每个元素要占据足够小的区域，以使场量能被节点值

充分的内插替换。  

 

然而，要产生场解决，就要用足够的元素来反演矩阵，这些元素的数目近似等于四面体节点数。对于有大

量元素的网格来说，这样一个反演需要大量的计算资源和内存资源。因此，较合理的方法是使用这样的网

格：用它可以得到较为精确的场解，但是又不会超过可得到的计算机内存和处理能力。  

 

为产生最佳网格，HFSS使用了反复过程，或称为适应性分析，在此分析中可以自动地将网格精修为临界

区域。首先，它产生一个基于粗糙原始网格的解决方案，然后，在错误密度较高的区域进行网格精修并产

生新的解决方案。当所选的参数收敛进入设定范围后，HFSS跳出循环。  

 

HFSS解决过程  

 

为计算与带端口结构相关联的 S参数，HFSS进行如下工作：  

 

● 将结构分为有限元网格。  

 

● 计算该结构每个端口上的模式，这些端口被传输线支持，这些传输线具有和端口相同的横截面。  

 

● 计算该结构内的所有电磁场模式，假定一次激发一个模式。  

 

● 从反射量和传输量计算一般 S矩阵。  

 

所得到的 S矩阵允许通过给定的输入信号直接计算传输值和反射值，从而将三维电磁场行为简化为一组高

频电路参数。  

 

网格产生过程  

 

以下是一般的网格产生过程：  

 

1、 HFSS产生初始网格，该网格包含表面逼近设置。  

 

2、 如果需要 lambda精修，HFSS基于材料依赖的波长对初始网格进行精修。  
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3、 任何定义的网格操作都用来精修网格。  

 

4、 如果定义了端口，HFSS就反复精修端口上的二维网格。  

 

5、 利用结果网格，当电磁场在解决频率被激发时，HFSS计算存在于结构内的电磁场。  

 

6、 如果是执行适应性分析，HFSS使用当前的有限元素解来评估问题区域中精确解有重大错误的区域。

这些区域中的四面体会被精修。  

 

7、 HFSS使用精修过的网格产生另一个解。  

 

8、 HFSS重新计算错误区，反复过程（解决——错误分析——适应性精修）不断重复，直到满足了收敛

准则或完成了适应性路径的最大数目。  

 

9、 如果执行频率扫描，HFSS就会在其他频率点求解问题而不会进一步精修网格。适应性解决只在指定

解决频率执行。  

 

注意：HFSS并不在每次开始解决过程时产生初始网格。只有当当前网格不可得到时才会产生初始网格。 

 

相关主题：恢复至初始网格，播种网格，播种网格指导方针，基于长度的网格精修，基于趋肤深度的网格

精修，表面逼近设置，修改表面逼近设置的指导方阵，网格区与问题区，端口网格精修。  

 

播种网格  

 

在 HFSS中，网格操作指的是可选择的网格精修设置，该设置使你能根据自己所知的模型几何知识为 HFSS

提供相应的工程指导方针，这些模型几何对于一个结构的电磁场行为来说是必不可少的。在开始适应性分

析过程之前提供这些指导方阵能够减少（有时大大减少）收敛于场解决方案时的路径数目，还可减少此解

决方案网格中最终的四面体数目。虽然适应性分析收敛于可找到场行为的区域，使用更多的标准（而不是

标准设置）来精修网格，例如材料属性，可以在最初的几个路径解决之后，尽快的找到临界场行为区域。 

 

指导 HFSS网格建设的技术称为“播种”网格。播种通过执行 HFSS>Mesh Oprations命令来实现。  

 

你可以精修表面或体积内的四面体元素的长度直到它们低于某个特定值（基于长度的网格精修），也可以

精修表面或体积内四面体的表面三角长度使其低于某个特定值（基于趋肤深度的网格精修）。这些类型的

网格操作可以在任何时候定义。如果你想在适应性分析过程之前应用他们，他们可用于在初始网格产生之

后对其进行精修。你也可以选择“应用网格操作而不产生解决”，在这种情况下网格精修应用于当前网格。 

 

在某些特殊情况下，你想为一个或多个表面定义“修改 HFSS表面逼近设置”的网格设置，表面逼近设置仅

应用于初始网格。  

 

相关主题：定义网格操作   

 

技术资料：网格产生过程  
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播种网格指导方针：  

 

当播种网格不是必需时，以下情形是有用的：  

 

● 在模型几何的以下体积内播种网格：在该区域希望得到较强的电场或磁场（具有较大的电容性负载或电

感性负载）。例如某共鸣结构内的容性裂缝，锋利的波导角度或拐角，滤波器结构中多耦合线间的间隙。 

 

● 在每个具有高纵横比边界的表面播种网格，例如长 PCB迹线或长导线的表面。使网格点间距大致等于

导线直径迹线宽度使你能够从第一次适应性路径中更精确地捕获到高表面结构的行为。  

 

相关主题：定义网格操作  

 

基于长度的网格精修  

 

当你指定了基于长度的网格精修，你指示 HFSS精修网格，以使四面体元素的长度低于某个特定值。四面

体的长度定义为它的最长边的长度。  

 

你可以指定位于表面或实体内部的四面体的最大长度。也可以指定每次精修时添加的元素的最大数目。当

初始网格产生后，你指定的精修标准将用于精修初始网格。  

 

相关主题：在实体表面分配基于长度的网格精修  

 

在实体内部分配基于长度的网格精修  

 

基于趋肤深度的网格精修  

 

当你指定了基于趋肤深度的网格精修后，你要求 HFSS精修位于表面的所有四面体元素的表面三角长度，

直到其低于某个特定值。基于表面网格建立了一个分层网格。各层根据趋肤深度和你指定的层数分级。  

 

在基于趋肤深度精修的过程中，HFSS建立一系列平行于实体表面的层，各层间隔位于趋肤深度范围内。

对于平面表面的每个点，一系列点（P0,P1,P2,……,Pn）被添加到网格中，n是层数。P0是表面上的点，

P0至 Pn的距离是趋肤深度。这些点以非均匀间隔的方式隔开，从 Pn到 P0，他们的距离以几何级数的方

式递减。  

 

例如，如果  

 

趋肤深度： 12mm  

 

元素层数的数目： 4  

 

则有  

 

距离[P0,P1] 0.8mm  
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距离[P1,P2] 1.6mm  

 

距离[P2,P3] 3.2mm  

 

距离[P3.P4] 6.4mm  

 

距离[P0.P4] 0.8+1.6+3.2+6.4=12mm  

 

基于趋肤深度的精修首先满足表面三角边长标准，然后引入一系列点到额外层。如果一个限制应用于网格

增加，会发生下面的一种情况：  

 

● 限制高到足够完成趋肤深度精修。  

 

● 限制高到可满足表面三角边长准则，但是没高到完成深度播种。  

 

● 限制甚至没高到满足表面三角边长准则。  

 

因为根据趋肤深度精修会增加许多播种点，你首先应该用基于长度的精修来精修表面，这样就能得到 HFSS

使用基于透入深度精修时所要添加的点的精确数目。这样做使你能在进行趋肤深度播种之前达到表面边长

准则，并且逼近网格中的元素数目和表面点的数目。  

 

相关主题：在实体表面分配基于透入深度的精修。  

 

表面逼近设置  

 

HFSS的实体表面可能是平面、柱面、锥面、圆环面、球面、曲面。原始模型表面称为真表面。要创建有

限元网格，HFSS首先将真表面分成三角形。这些三角形表面称为琢面表面，因为一系列直线段片断代表

每个弯曲的或平坦的表面。  

 

对平面来说，三角形精确的落在模型表面上；真表面和网格表面在位置和法向上没有区别。当实体表面是

非平面，琢面三角平面与实体真表面有一小段间距。这个距离称为表面偏差，它以模型的单位来衡量。表

面偏差与三角形的中心距离更接近，而与三角形顶点的接近程度较小。  

 

曲面上不同点上的法线方向不同，而三角形上各个点的法线是一致的（在这里，法线被定义为垂直于表面

的线）。曲面与相应的网格面的法线角度的差别称为法向偏差，法向偏差以度来度量。  

 

平面上的三角形具有纵横比，其值依赖于该三角形的外接圆与内切圆半径之比。对于等边三角形来说它是

一个固定值，当三角形变窄时它变的趋于无穷大。  

 

在 Surface Approximation对话框你可以在一个或多个平面上一次修改表面偏差，最大允许法向偏差，三角

形最大纵横比。（执行 HFSS>Mesh Operations>Assign>Surface Approximation）  

 

表面逼近设置应用于初始网格。  
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注意：对于初始网格，三角形的所有顶点位于真表面上、在适应性网格中，顶点被添加到网格表面上，而

不是真表面上。  

 

相关主题：修改表面逼近设置  

 

技术资料：修改表面逼近设置指导方针  

 

技术资料：网格产生过程  

 

修改表面逼近设置的指导方针  

 

如果你打算为实体的一个或多个表面修改表面逼近设置，记住以下准则：  

 

● 如果有必要，覆盖掉默认表面逼近设置，以便更精确的描述曲面。更精确的描述将增加网格尺寸并需要

更多的 CPU时间和内存。  

 

● 如果你想通过使用较粗糙的曲面描述从而得到一个快速解决，对整个实体设置粗糙设置，而不仅仅是单

个表面。  

 

● 当纵横比的值被设为 1时，HFSS很难满足此命令，因为一个任意形状很难完全用等边三角形来填充。

因此，将纵横比设为 1会导致不合理的大量网格。HFSS将平坦实体的纵横比设为 4而将曲面实体设为 1.2。 

 

相关主题：相关表面逼近设置  

 

技术资料：表面逼近设置  

 

网格区与问题区  

 

HFSS区分网格区与问题区。问题区指的是产生解决并精修网格的区域。网格区包括问题区，指的是生成

初始网格的区域。当初始网格产生之后，仅在问题区对网格进行精修。  

 

问题区包含的区域刚好将整个设计包含其中。而网格区至少要比模型大十倍。网格区中未被实体占据的部

分被认为是背景实体。背景延伸至网格区的边界并且填满任何未被实体占据的空洞。因为背景实体被定义

为完美导体，即使其中产生了网格，背景区中也不产生任何解。HFSS在解决过程中自动定义网格区。  

 

问题区与网格区可通过下图说明。  

 

端口解决  

 

每个端口的激励场模式必须在求解该结构内所有三维电磁场之前进行计算。HFSS计算自然场模式，这些

模式可以存在于与端口有相同横截面的传输结构内部。作为结果的二维场模式作为全部三维问题的边界条

件。  

 

激励场  

shared by:www.cnantennas.com

www.cnantennas.com



 

HFSS假定每个端口联结在与端口有相同横截面的统一波导上。因此，激励场就是与传导波有关的场，该

传导波沿着与端口连接的波导传播。  

 

 

其中， 是复数或复函数的实部。  

 

E(x,y)是一个相位矢量场。  

 

是复传输常数，其中  

 

是波的衰减常数。  

 

是与波有关的传输常数，该波决定了在给定时间 t下，相角如何随着 z而变化。  

 

是角频率， 。  

 

j是虚部单位， 。  

 

在这里，x轴和 y轴被假定位于端口横截面上，z轴则沿着波传播方向。  

 

波动方程  

 

波导内传导波的场模式可通过解麦克斯韦方程组得到。以下波模块要求解的方程可直接通过解麦克斯韦方

程组得到：  

 

 

其中，E(x,y)是代表振荡电场的相量。  

 

K0是自由空间波数， 。  

 

是角频率 。  

 

是复相对磁导率。  

 

是复相对电容率。  

 

当波模块解这个方程时，它得到了以相量 E(x,y)形式表示的激励场模式。通过相应的与 H有关的波动方程

它还能独立求解 H(x,y)。这些相量解对于 z和 t来说是独立的，只有在被 相乘变为传导波时才与 z相关。 

 

同时注意由波模块解出的激励场模式只有在给定频率下才有效。不同的激励场模式在感兴趣的不同的频率

点下求出。  

 

端口上的网格精修  

shared by:www.cnantennas.com

www.cnantennas.com



 

波模块计算激励场模式时将其看作二维有限元问题。与端口联系的网格只不过是与端口表面相对应的四面

体三角的二维网格。波模块对此二维网格反复计算而不用到“网格产生器”。  

 

精修过程如下：  

 

1、 使用初始网格四面体表面三角网格，波既求解磁场 H，也求解电场 E。  

 

2、 要确定二维解是否精确，波使用如下公式：  

 

 

 

其中 H和 E都是相量。  

 

3、 波首先使用合适的波动方程独立计算 E和 H，然后，它计算 并将结果与已求出的 E比较，然后计算 并

将结果与已求出的 H比较。  

 

4、 如果比较结果落在允许偏差内，则接受该解，否则端口上的二维网格将被精修，波会执行另一次反复。 

 

5、 任何已被添加到端口表面的网格点都会被读出到已有的网格文件中。下次当网格产生器开始工作时这

些点就会被组合到全部三维网格中。  

 

要详细了解波模块执行理论，参考下文：  

 

Jin-Fa Lee, Din-Kow Sun, and Zoltan J. Cendes, “Full-Wave Analysis of Dielectric Waveguides Using 

Tangential Vector Finite Elements,” IEEE Transactions on Microwave Theory and Techniques, vol. 39, 

No 8, August 1991.  

 

相关主题：技术文件：网格产生过程  

 

模式  

 

对于有假定横截面的波导或传输线，存在一系列基本场类型，或模式，可以满足特定频率下的麦克斯韦方

程组。这些模式的任意线性组合都可存在于波导中。默认情况下，HFSS只计算占主导地位的场模式。 
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HFSS学习小结 

已经接触 HFSS近两个月了，想用于材料电磁场屏蔽的设计和计算，不知是否可行，
now have followed the example _heat sink in the chapter 9.0 _ EMC/EMI in full book 
10.0 成功的做出了个结果，现在把看到别人的、自己知道的做一下总结：The main 
process : building 3D solid modeling; set boundaries and excitations ; analyze the result 
Before we build the modeling, we should think about what kind of method we use, there 
are three kinds of solution type: driven model; driven terminal; eigenmode 模式驱动
(Driven)------计算以模式为基础的 S参数.根据波导模式的入射和反射功率表示 S参
数矩阵的解,波导,天线等用这个模式多终端驱动(Driven Terminal)------计算以终端
为基础的多导体传输线端口的 S参数。此时,根据传输线终端的电压和电流表示 S
参数矩阵的解----微带类用这个比较多! 本征模(Eignemode)-----计算某一结构的本
征模式或谐振.本征模解算器可以求出该结构的谐振频率以及这些谐振频率下的场
模式! Eignemode solver does not use ports and don’t support radiation boundaries. 
After launching the software, we should set tool options, included HFSS option and 3D 
modeler option Select the menu item tool >option  we can see those options Software 
will open a project by default First step is select solution type  HFSS>solution type Set 
the units  3D modeler>units 单位可以在其它状态下改变 3D modeler 包括了与模
型有关的操作和设置 Set default material  在 set 一次后的情况下其后建立的
modeler 都是在此material 下的 在 default 的情况下 history 的列表中按材料的种
类进行分类建立模型过程中使用相对坐标会很方便， 3D modeler>coordinate 
system > create> relative CS >Offset , 在建模过程中可能要使用很多相对坐标，在
set相对坐标的时候，offset是相对于当前 CS的位移，在 3D Modeler>coordinate 
system>set working CS 可以选择使某个坐标为当前工作坐标，在 history 的
coordinate system 的列表中显示所有的坐标系，当前工作坐标将有个W的标记。
在模型复杂的时候需要用适当的方式进行选择某些面、体进行编辑，在 edit 里提
供了多种方式，常用 edit>select>by name   在选择后可以 set boundary 等一些操作
同样可以在 history里双击某项名字从而 edit property，设置好 boundary和 excitation 
就可以进行 analysis setup HFSS>analysis setup>add solution setup 其中包括最大迭
代次数 maximum number of pass  每两步迭代之间的误差，看来上的数值分析还是
有用的在 analyze 之前运行一下 model validation   select the menu item 
HFSS>validation check 运行 check 以后虽然没出现问题，也不能说明，模型正确，
一定能计算出结果，只是说明完成了建模过程中的每个步骤,由 message 窗口，得
到信息，以便修改 Analyze   HFSS>analyze all 在 message 窗口中可以知道 analyze 
的完成情况；从 solution data 中有三个标签，其中主要可以从 convergence中看出
迭代计算的收敛情况；同样可以看到场的分布状况 首先选择 model 某个部位，
HFSS>fields>fields从这个菜单中可以选择要显示电场或者磁场例子中选择的是地
平面 edit>select>by name>ground 显示某个部位的场分布 HFSS>fields>fields> 可
以看到关于显示电场 磁场的选择下图是 heat sink 的 ground configuration 的
ground 的电场分
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HFSS帮助文件翻译 
 
 
单频率解决  
 
单频率解决在单个频率点产生适应性或非适应性解，解决频率在 Solution Setup对话框中指
定，并且通常是执行频率扫描的第一步。适应性解决指的是建立有限元网格并自动精修错误

最高的区域——从而提高了随后的适应性解的精度。执行单频率解决方案的程序如下所示：  
 
频率扫描  
 
当你想通过一个频率范围产生解时，使用频率扫描。你可以选择以下一种扫描方式：  
 
快速：为每个小频率范围产生唯一的全场解。最适用于突然共振的模型或在频带内改变操作
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的模型。一个快速扫描方案可以得到场在谐振点附近行为的精确描述。  
 
离散：在频率范围内特定频率点上产生场解。最适用于只用频带内一部分频率点来精确描述

结果。  
 
插入：用来评估全部频率范围内的解。最适用于频带很宽且频率相应比较光滑的情况，以及

快速扫描的内存超出了可用值。  
 
快速频率扫描  
 
快速频率扫描为每个小频率范围产生唯一解。当模型在频谱范围忽然谐振或改变行为时选择

快速扫描。快速扫描能得到谐振点附近行为的精确表示。  
 
HFSS使用频带中心频率选择合适的特征值问题从而为整个快速扫描产生一个解。然后使用
基于适应性 Lanczos-Pade扫描（ALPS）的求解器从中心频率场解来外推要求的频带范围的
场解。  
 
如果解决频率位于频带范围内（比起始频率高且比终止频率低），HFSS 将解决频率作为中
心频率。否则频带范围的中点被用作中心频率。  
 
记住，HFSS在解决频率的适应性解决中使用有限元网格精修，如果你没要求适应性解决，
产生的初始网格将应用于问题。系统将使用这个网格而不再进一步对其进行精修。同样，中

心频率的场解是最精确的。取决于你在频率范围内要求的精度水平，你可以在其它中心频率

执行频率扫描。  
 
全场解只在中心频率被保存，而 S 参数在所有频率点被保存；然而，快速扫描允许扫描范
围内所有频率项的后处理。  
 
快速扫描所需要的时间大大多于单个频率解决的时间。  
 
注意：当执行快速扫描时，频率范围内的任何端口模式不能与切口相交叉。如果出现了交叉，

一个错误信息就会出现，列出违反这个原则的端口和模式。  
 
快速扫描程序如下所示：  
 
离散频率扫描  
 
离散扫描在频带内的特定频率点产生场解。例如，指定频带 1000MHz 到 2000MHz，步长
2.5，结果是 1000，1250，1500，1750，2000MHz的解。默认情况下，只有最后计算的频率
点的场解会保存，在这个例子中是 2000MHz。设置了求解点后，如果你想保存特定点的场
解，选择 Save Fields，每个频率点的 S参数被保存。你要求的步数越多，完成频率扫描所需
的时间越长。  
 
如果频带范围的解只需一些频率点就能精确表示，选择离散扫描。  
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记住，HFSS在解决频率的适应性解决中使用有限元网格精修，如果你没要求适应性解决，
产生的初始网格将应用于问题。系统将使用这个网格而不再进一步对其进行精修。由于适应

性解决的网格仅在解决频率处被优化，对于和此频率相差较大的频率，结果的精确度可能会

有很大的变化。如果你想使变化最小，你可以选择频带中心作为解决频率。然后，检查了结

果后，在解决频率设置为临界频率时运行额外的解决。  
 
插入频率扫描  
 
插入频率扫描评估了全频范围的解。HFSS选择计算场解的频率点从而使所有内插替换解落
在允许误差内。当解达到允许误差标准或产生了最大数目的解后，扫描完成。要了解解的更

多信息，增加步数并重新执行扫描。  
 
每个点的场解都会被删除，这样下一个点的新的场解就会产生。只有最后计算的频率点的所

有场解才会被保存。每个频率点的 S参数都会被保存。  
 
当频率范围很宽或频谱响应较为平滑，或者快速扫描的内存需求超出可得到的内存，选择插

入扫描。插入扫描所花的时间比离散扫描少的多，因为全场解是基于最少频率点被内插替换

的。插入扫描的最大时间可表示为单个频率解决时间乘上最大解决次数。  
 
记住，HFSS在解决频率的适应性解决中使用有限元网格精修，如果你没要求适应性解决，
产生的初始网格将应用于问题。系统将使用这个网格而不再进一步对其进行精修。  
 
解决类型(求解器设置)  
 
受驱模式解决  
 
当你想用 HFSS计算微波传输带，波导，传输线等被动高频结构的基于模式的 S参数时，选
择 Driven Modal。S参数解决将用一系列波导模的入射和反射能量来表示。  
 
受驱终端解决  
 
当你想用 HFSS 计算基于终端的多导体传输线端口的 S 参数时，选择 Driven Terminal 
Solution。S参数的解将用一系列电压和电流来表示。  
 
本征模式解决  
 
当你想计算一个结构的本征模式，或者谐振时，选择 Eigenmode Solution。本征模式解决器
找到结构的谐振频率并计算在这些频率点的场。  
 
本征模式解决  
 
本征模式解决器可以找到损耗结构和无损结构的本征模式，可计算空腔的无负载 Q。Q是品
质因数，是系统消耗了多少能量的量度。无负载 Q 是由无损材料造成的能量损失。因为端
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口和其他源被限制在本征模式问题中，被计算的 Q不包括由这些源造成的损耗。  
 
以下限制应用于本征模解决设计：  
 
以下激励不可被定义：端口，入射波，电压源，电流源，偏置磁场源。  
 
辐射边界不可被定义。  
 
频率扫描是不可用的。  
 
你不能观察或绘制 S矩阵参数。  
 
设计不能包括铁素体。  
 
计算谐振频率  
 
本征模频率（结构的谐振频率）如下计算： ，其中 c是光速，f是波频。  
 
计算品质因数  
 
Q是无负载品质因数，是结构中由损耗材料造成的能量损耗多少的量度。因为端口和其他源
被限制在本征模式问题中，被计算的 Q不包括由这些源造成的损耗。  
 
HFSS使用下式计算近似的品质因数，其中 U是空腔存储的总能量，P是功率损耗，例如电
阻损耗。  
 
计算自由空间波数  
 
自由空间波数 k0谐振模式的频率有关，对于无损问题通过下式计算，其中 S和 T是依赖于
模型几何和网格的矩阵，x是电场解，k0是自由空间波数。  
 
场解  
 
在反复适应性求解过程中，在所有场解之前 S 参数是典型的稳定。因此，当你有兴趣分析
与某个结构有关的场解时，使用比正常情况更严格的收敛准则是需要的。  
 
另外，对于任意给定的适应性反复的数目，解出的磁场（H场）比电场（E场）的精确度低，
因为磁场是通过它跟电场的关系 由电场计算出来的。  
 
场覆盖图  
 
在 HFSS中，场覆盖代表在表面或实体内的基本场量或派生场量。绘制场的实体可以是模型
几何中已经存在的部分，也可以是你在后处理模式中回转的实体。如果你选择了一个表面，

HFSS将在表面绘制场量。如果你选择了一个实体，HFSS将在该实体的体积内部绘制场量。
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你可以选择绘制场的标量图或矢量图。标量图使用渐变线来说明表面或体积内的场量的数

量。矢量图使用箭头来说明场量 x,y,z分量的数量。  
 
场量  
 
默认的能被绘图的场量，它们的定义，以及相应的单位如下所示：  
 
场量                         定义                    单位  
 
Mag E                 电场模                V/m  
 
Mag H                 磁场模               Amps/m  
 
Mag Jvol              体电流密度模         Amps/m2  
 
Mag Jsurf             面电流密度模         Amps/m  
 
Complex MagE          电场复数模           V/m  
 
Complex MagH          磁场复数模           Amps/m  
 
Complex Mag Jvol      体电流密度的复数模   Amps/m2  
 
Complex Mag Jsurf     面电流密度的复数模   Amps/m  
 
Vector E              电场                 V/m  
 
Vector H              磁场                Amps/m  
 
Vector Jvol           体电流密度 J(x,y,z)           Amps/m2  
 
Vector Jsurf          面电流密度 J(x,y,z)           Amps/m  
 
    Vector Real Poynting  坡印亭矢量，定义为 E x H*     W/m2  
 
Local SAR             特定吸收率                   W/kg  
 
Average SAR           平均特定吸收率               W/kg  
 
指定相位角  
 
指定场量被计算时的相位角使你能计算场数量在其周期不同点上的实部。这些量可表示为

A(x, y, z, t) = A(x, y, z)cos(ωt + θ(x, y, z))，其中ω是场量相位角振荡频率，在解决时设定。
θ (x,y,z)是相角（余弦波偏置量，峰值在 t=0）。  
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峰值与 RMS相量的对比  
 
这部分关注场量在 HFSS中是如何表示的。有些用户用不到这些信息，例如想知道端口 S参
数或场解相对振幅的用户。而想知道场量绝对值的用户需要考虑两种场表示方式的不同，即

峰值和平均值。HFSS在频域解决并获得定态有限元场解的相量表示式。物理量如瞬时（时
域）电场随后作为派生量从相量表示式中得到。  
 
如果 Ex是代表时谐电场的“峰值”相量的 x分量，在时刻 t的物理电场 x分量，表示为 Ex(t)，
通过 来计算，其中 R 是复数或复函数的实部， 是角频率，j是虚部单位，t是时间。另外，
如果 Ex是一个“均值”相量，一个额外的因子 是必需的，即 。作为这些公式的结论，在
一个整周期内观察到的峰值物理场（Ex(t)），在峰值相量中 max(Ex(t))= ，而在均值相量中
max(Ex(t)= 。  
 
另外，给定了相量 E 和 H，要计算通过一个平面的平均能流，复坡印亭矢量的实部 x 分量
要沿着表面积分。复坡印亭矢量 S的正确表达方式取决于使用了那种相量。对于峰值相量， ，
对于均值相量， 。  
 
HFSS的使用惯例如下：  
 
入射到一个端口上的每个传输模式包括 1瓦特的时间平均功率。  
 
电路差值源用峰值形式来表示。也就是说，如果电势差源数量是 5伏，那么时域电路源表现
为 。同样的情况也适用于电流差源。  
 
平面波源用峰值形式来表示。也就是说，如果平面波数量是 5V/m，平面波入射场数量可表
示为 。  
 
辐射功率，例如通过场后处理器计算的，是用复坡印亭矢量计算的时域平均量。  
 
场计算器中的相量是峰值相量。计算器中的坡印亭矢量按钮因此用峰值相量执行坡印亭矢

量 ,无论是计算平均量还是瞬时量的计算都要遵守峰值相量惯例。  
 
计算 SAR  
 
特定吸收系数(SAR)是损耗介质材料中电磁能量吸收量的量度。SAR 是一个基本的标量场
量，可以用 HFSS在实体表面或内部被绘制。HFSS使用下式计算 SAR： ，其中 ＝材料电
导率， 是电介质的质量密度，单位是质量/单位体积。  
 
HFSS中有两种类型的 SAR图：局部 SAR和平均 SAR。当计算局部 SAR时，HFSS使用上
述公式计算覆盖图中每个网格点的 SAR。HFSS沿着图内插替换网格点之间的值。在绘制平
均 SAR 时，对于图上的每个网格点，HFSS 报告一个包围该网格点的小体积的平均 SAR。
该体积由以下设置确定：材料的质量密度，包围每个网格点的材料质量，它们在 Specific 
Absorption Rate Setting对话框中设定。 
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